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1.1 DERHEE
Bree J I S — B ) ARMO RN SUBEH ™ i AR A (0 F5 12 (R iR AN AR H i
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— A S RN U, 41 EM9160
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G LUK R 2

A EUT Y
— IR R TR
Microsoft /2w [¥] Windows CE core %) 1E I 4% AUbR I

SRR AP X X HER R A SR SR AR 3R DBt 5 [ T
I VP Ak AR L 22 2BEAT AN I R 93, DL, IR AN SRR 52— AN O — FEX i AE 55 1%
IR AR SRATRC B HIT R PR, B — B BEBRTT R R S

BE P B SRR N B TF R A E 3R FIH TP IR, B N — e 8
i

o i HAA+5V HU i 1 AR R R BT O R AR (#5V £5%), Hf
TEAFAL 1 LU FUR e IE A M B B AR 1 +5V Bl b G
T g P #tT GPRS/CDMA WHTFR, T GPRS/CDMA i it LR i 1)

[k 1) P ATk 2A, IR RS T O Ha s InT ik i tH D) %A 10W B .

® M —ALUKM B DR 2D —A RS232 H ) PC HUE AT R EHL, % PC #HL
2% Windows XP 4k & 4;

o I AUl AL E#E HUB 57 R U R .

o I R EAE AN AU S L e, TR A IR LR
2. JERENL ip Hihk— e 2 5 IR EHLIY ip sudik e Rl BN .

o JUEAEMLTM, HR TINPRIF R, IR U — PR L, LCD B,
H BT EM9160 1] [ 337 35— Fhi 1 i) LCD K. (1) 128X64, KS0108 #54H#s
(2) 320%240, SED1335 #xifil#%; (3) 240X 128, T6963C #4Hilgs. U fi
HI EM9160 )%/t ] LA &6 20 m) 1 75 2211 LCD it X AT % LCD
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WG 7 BT TR S AN FR K B T BLE— 285 T A s EERC #5427 AT REIE
A LG TR, e

o G ERIERY M, W AD Bk, 10 ¥ RS

® GPRS/CDMA il iflbib (fu1: Siemens MC39i) LA K K2k %5 b4
® SD fffiF

® )R B H A

IRLEFRAF BB 5%, TS5 AN i A U 9 0

1.2 JFRAEREEREM

TELL B ER IR LU, mlin] DAEAT R A EE (R R34 T o

PRUENCE 5] ARMO ik N BEEAR FECAT 7R Flash W74, JFNE T IERR
Windows CE #:1E & %8, %R K ENL EAEH eVC FFR N T, FFid DLOK k156l
RN U T e AR .

TN BRI TF R PP EAR AR 045 T GPRS Jo4il il 1196, RS485 it
RS232 Jffi s 5 e s 0 LCD 211 F PRSI 11, USB 2 FURT LUK I 48452 1145, X 4z
PV ) H P, ERE G SORS o P A0 DA SR SR B Bl -2 11 AR T RE R ¥ o TR R VAR
WA AT LA AR TF R A S B b, T AETF ROk EE A R BE Ef PCB &I m] LAk F
RAETHATHIME B v IR — e 1 23, DUE TR (0 SR T AT 18 o0 sl o i o
TG, EFHHTES B ORI AL, PO AL R O R

TN A PR TAERER: B AR B T, PR VPN AR A — T
FEIBATAE R AN R R 2 AT VI Bk JPA, FF Bk s T, RGO IE W18
s N, RIS S, W 11, FSEEAT IR AN, SRR SR
BAbFRRE, B JP1 A FHRBRIRAS . IR H BT VRSO AT N R P 2 0, % e
i R A I SCA SO (dbginfo.txt / userinfo.txt) Skt RATHEAT AT AL E (A
PRIC B VENGAE G SCHAT A 4D

SRR
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1-6  SCFFHL( LCD 7R 1) ARMO BBk 5 5 5t
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2 TERRIERE

21 TAEERSANA

S0 ARMO 1 N AT W R TAERER: Y BB AE AT, 760 B P TT R PR 85
2R, PP XX PR AR AT T R, LM T T .

PR HR T HLLLUS R4 T BOIRA, B I oT LUl eVC &z i it T A
ERAEPEOIREY, SCOLR AR FRAMIA. SO B iRE. TP R B, RAREL T
FORA R

BT I THLLAG RS E B TFUAIT I 8 ORI o TFR SERG, N SZ BRI I
RYBIER TIXFRA T

YE) ARMO R SUBEER TAE T Rk moms— Rk, FLIm PRI FRBkZas JP1 ok
SRR (JPT (E VAR IERE i EL AR LI 1-1) 0 JPA S, M TAEFIRRBE R JP1 ITF,

W TAEF 1847 5K

2.2 ARGECESCHUHA
B BBk A LLAN, F IR 75 EUE O A B2 11 314 dbginfo.txt 1 userinfo.txt K4
RIS AT I B L E IS4

2.21 dbginfo.txt
dbginfo.txt HTERAF IS E IR T HARHURITF R AL NS S5, TR RGEATIF K
PR, T DAZ0 S e A % SO i 58 O A7 T O QB “NandFLASH” H sk, oy &
%I CORURVER S 08 30 43 D i AR B 507, FFANELRR AR SO )
[LOCAL_MACHINE] AERZ IR
DefaultGateway="192.168.201.8" //ERINWI S, A4 H T 45 9 4% (1) S s e B A o
WY 0.0.0.0, TSR B AT (¥ AC
IPAddress="192.168.201.205" ITEHFRHLIP Mok, @)™ BATICE
SubnetMask="255.255.255.0" 15 WS, AR ™ BITAE R 45 1) S Bn i B S
[HOST_MACHINE] HIF R ENUE B

IPAddress="192.168.201.4" IDFRENL P Huhik, KRG BN S br i B IS
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port="9300" 15105, SEFIBRIAE 9300, ANfEfs
[SYSTEM] TIA7fik 2 )
Store="50" IS SR P SO v ) 50% A7 20 18] (1D

Zm4E LT dbginfo.txt JFAEA U B O, ¥4 U S PR USB #2101 I, Hi#z JP1,
RJG LA, REHBSHXASCEFAE] “NandFLASH” Higrb, JFziat lyzft
BROATCE ot L P 1 BRI 0 28 SO O, W BAJS b U8 3 i 0 08 75 P4 U it
PRBUR B, RGO “NandFLASH” H I E S50 WR M4 S50k E T 21K,
YU T P % 4% BT 1 B 8B Bk dbginfotxt, JEFFUGEIE U B30I A SO R B RS
“NandFLASH” Hzxtr, BLtibk REEHICHT IR E .

71:: Store HI T4 At 2 1], X515 b A IR 407 R 3R 0 SO o FH IR A4 2 1) 1 4 L

gefi ovml ) BRCKE NorFLASH #5345 R4 fI ) (BRI 50%), HIJ/ ) LA
MR EZS RO B DG N H TR, P, P RE e 70%0
LEfAsE], A %0 R E: Store="30", i%Z M4 A FLE 10-90, /T 10
BT 90 IR B E R EAARAE, M RECR T B .

2.2.2 userinfo.txt
userinfo.txt T {RAF 2 AEIZ AT IR T HARHLI NS EONTFNL B 3z 17 IR 1 S 4L
CAERGITHL A Sz AT N IR, 0 2502 56 5 9% SO A 4 B 50 W OT A7 T 9 @ BB
“NandFLASH” Hzgr. H AR Lag N (OURHR S 0 (23 0 v i W S, I
AFELESCAF D
[LOCAL_MACHINE] SR YIRS,
DefaultGateway="192.168.201.8" //ERINI G, HEHE /(1 L BrisAT M 45 R BE . 1%
W bk 5 dbginfo.txt H1 1 EEAS— i AH [F]
IPAddress="192.168.201.205" ITEFRHL P $idik, A BATIRE . 1% IP ikl
dbginfo.txt H (1% B A2 M 7]
SubnetMask="255.255.255.0" I WA, AR P A S pris AT A IR, % T
pIfEG 55 dbginfo.txt o B E A —E AR
[USER_EXE] HFH PR A
Name="serialtest.exe" HRGFEHLA BT IR, BRIAK serialtest.exe.
SRR TT A 5E LR HE R B SRR TR P S 44
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BAERUS |5 2 (AU H 1T BRA SR 44, FRRLED
i HahistT ()

Parameters="COM1 9600" ARG I H B PAT R I S E . shAbh
serialtest.exe Z4(: WL COM1, JBFFA N
9600, F & 56 LA 7 AL BN 552 B 3 F 23 (1
A, WERBCA WA, R 23R B X5 |

[SYSTEM] T4 At 2 [B] ] 3

Store="50" IR GESCATF R SCPE# o ) 50% A7 fifh 2 18] (7D

W 1. T “serialtest.exe” 7T WIinCE BRI ARG CAEIE T, Motk Ao
i 8 SEAP A B s T SE B B YRR s I R G2 “NandFLASH” [
s, PR P e g userinfo.txt [ I I 1248 s 8 R BT 407, B
“Name” J& 14V izan ko (HAb P userapp.exe A HD:
Name="\NandFLASH\userapp.exe"

2. Store ZHi) & XAl I 75 15IA] userinfo.txt.

SR T userinfo.txt, B IT R EHL S 0] ARMO fix AU 3% %, it eVC #i%
PR SR B S8 (N TR A 1) “NandFLASH” H s CRESTIERELL K SO 5 461
W77 G300, #e FREIT JP1, AR5 LHUHZ), R userinfo.txt i N 284F 0 BR
WHLE, L RZ SO B A TR N FE 7 o W P F5 S Oy R, DU AT LA $4 e
Btz HUE Y userinfo.txt, FFHUGELT eVC LA AR LLKHT N FIFE 561 2] R 41
“NandFLASH” Hxtr, BLtik RGERICHT I NCE .

He o RN ERP AR RN S FRIP S TSR, MIETEES

i &0
2. W RAUR IR IR B, WJE %% userinfo.txt.
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3 B ARAEN RN E

@A H ) ARMO R AL ({035 EM9000 Fil EMO160), ZHEMAk 2wl eVC #EAT
R K . eVC 2R AR A N R G UL —E D e 5835 Hoal S 9 3R IR & L
H, 5 PCGHEMK VC RFF T MR —8, FINHE C/IC++PITHE, Ktk eVC
WAE A EMO160 N HIFEF TR A K i T H o AT A4 eVC e ad e AR A TR R A5G
. P BB 3SR ELY “eVC %23 ” FI “SOFTWARE” H¢ T,

3.1 eVC4 f1 eVCsp4 {23k

1. e eVC Z R, 7 E Ja i B3 Microsoft NET Framework 1.1, i21T “eVC

‘%%%/Dotnetfx” H % 1) Dotnetfx.exe, PN 3-1 Fros IV al BASOW 1R HE, L8 [F]

B P

i3 Microsoft NET Framework 1.1 3%

= 1

(Ali#idin1a]
Microso http-¥zo microsofl. comfwlinkTLinkld=
L3 - (12433 TEDEF AR

e rl-e-t NICROSOFT REFREEMH P FE3F i

{ 5hFrEmed )

*|

5]

EEGEE, TRTHARE (REAPFTH
ﬁf‘ E?&gn. 2R aaen
~ FEQ)

C FRE Q)

w_|

& 3-1 [ Microsoft .NET Framework 1.1 ¥F 1] Hp
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2. .NET Framework 1.1 (&3 FEn &l 3-2 Fios.

ji Microsoft MET Framesrork 1.1 5236 o I”'Eﬂ
m A IEFE = A F
EFEZentEi s TEE
MI[,‘.fﬂSD-ft' JKET Framewerk 075
Net
— | []]]]
EfEEEEI
'I I ilasm. exe confiz, BHF: C:...: 353
Mg 13 B
E

3-2 Microsoft .NET Framework 1.1 %% 0 #¢

3. .NET Framework 1.1 Z¢5e e LUA ginl LAEEAT eVC4.0 1) %eé. 11T “eVC %%%
/eVC4” H3 R setup.exe, R4 HAIHAMIE R, LT EE next, ] ZE8k
IR, 2 HILWE 3-3 s Vel OIS HE, E+E | accept the agreement, [7] 55 %%
il

- Installation Wizard for eMbedded Visval C++ 4.0 EI

End User License Agreement and Limited Warranty

T Be sure to carefully read and understand all of the rights

L, and raztrictiens dezcribed in the EULA Tou will be azked Lo
review and either accept or not sccept the terms of the EULA
and limited warranty. Thiz product will mot zet wp on your
computer unless or until you sccept the terms of the EULA and
limited warranty. For wour fulure reference, you may print
the text of the EULA fron the eula txt file of thiz product.
Tou may alse receive & copy of thizs EULA by contacting the
Bicrozoft subzidiary serving your couniry, or wrile:
Hicrosoft Sales Inmfornation Center/One Micrezaft Way
IBadecnd WA QENEO-ATCG

5
EH‘D‘US!R LICERSE AGREEMENT FOE MICROSOFT SOFTWARE

ICROS0FT EMBEDDED VISUAL C++ 4.0

TUFETANT-READ CARRFINIY - Thi= End-llcer Licencze deresment :I
Prezz the FAGE DOWN key Lo zee more text ..

oy E accept the Elmﬂ

™ I don’t accept the sgressent Brint ]
ST ETEE Bt |

K 3-3 [ eVC4.0 w1
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4, BT HIFES S EHE, FTHF “eVC Zefilkey” UM%, SRR S 4
A, WK 34,

. Installation Wizard for eMbedded Yisual C++ 4.0 i ___N'J

Product Number and User ID

Flease snter your product’ s ID punber:

[fRTTH - [iD36T - [FRMSD - [6QHBP - [CFTHO
Fleaze snter your neme and your company’ = name

Touwr name:

Ivr.-'n troniz

Tour company = nams:

Im tronix

Cpack [ Beet > | Bt |

3-4 G LARIFIS

5. FE2 %50 H ik $E J: b Standard SDK for Windows CE .NET, 414 3-5.
. Installation Wizard for eMbedded Visual C++ 4.0 i ﬁl

Install eMbedded Visual C++ 4.0

Select the items you want installed from the list below by
clicking om the check bexes. An item can be deselacted by
clicking again om its check bex.

afibedded Vizual CHt 4.0 Products:

g alﬂhedded v: :u.al |:++ 4 u

TN ETEE Exit |

K 3-5 [ WIinCE KIFs#E SDK
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6. ARG 2% Windows CE Platform Manager, #ifiilz:%%, fn 3-6.

Installation Wizard for eMbedded Yisual C++ 4.0 =]

eMbedded Visual C++ 4.0 requires Microsoft Windows CE Platform Manager to function properly,
The Installation Wizard will now install Microsoft Windows CE Platform Manager,

Please make sure all applications are closed before you continue, Would vou like to continue?

(M)

3-6 Wik %% WIinCE Platform Manager

7. WInCE Platform Manager [#) %35t/ 3-7.

Microsoft Windows CE Platform Manager 4.00

| Pleaze wailt whils Windoves configures Microsoft Windows CE
Plattorm Manager 4.0

Time remaining: 14 seconds

TR

K 3-7 ‘%% WIinCE Platform Manager

8. w5 LG, RSN KT AN LT, %P Continue, Wik 3-8, H7E
B FOR M JUASXHEHE LB OK.

eMbedded Yisual C++ 4.0 Setup ] |

@ YWelcome to the ebMbedded Visual C++ 4.0 inztallation progranm.
L=

Setup cannot install system files or update shared files if the files are in use.
Before continuing, cloze any open applications.

Exit Setup

3-8 HIASKHIN LY
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9. & PRIV ITHEWE 3-9, AMEEMIBN, Bk GRENA

BB e Ae, US4 a8 H N R LA 52D

eMbedded Visual C++ 4.0 Setup B d

I the Optionz list, select the items you want installed; clear the items pou do not want inztalled,

& grayed box with a check indicates that anly part of the component will be installed. To zelect
all components in the Option list, click Select All.

D escription:

T — e P e e

|7 Comman Components 15345 KB C++ werzion 4.0 and all required
components

Change Optioh... |

Select Al |
— Installation Location Folder
C:\Program Files\Microsoft eMbedded C++ 4.0 Lhange Folder... |
Space required on C: 101389 KB
Space available on C: 13321 MB
Continue I Canicel
& 3-9 HihHE R
10. RETFUR %4 eVC4.0, ik 3-10.
eMbedded Yisual C++ 4.0 Setup Disk x|

Destination File:
C:h AEVENWCE400MBIMSAT _MP.EXE

K 3-10 eVC4.0 &kl f2
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11, eVC4.0 %45 L n, BInl23%% eVCaspd. 21T “eVC % 3#5/eVCspd” H I R
setup.exe, 21 3-11 FrosPVFal PO 5HE, EFE | accept the terms in the License
Agreement, [F]& 2L

i{% eMbedded Yisual C+4 4.0 5P4 License Agreement x|

End-User License Agreement

Flease read the following license agreement carefully,

SUPPLEMENTAL END USER LICEN3E AGREEMENT FOR ﬂ
MICROSOFT SOFTWARE

Micro=zsoft Embedded Visual C++ 4.0 Zervice Pack

Felea=se 4

INPORTANT: EEALD CAREFULLY - The software components
accompanying this 3upplemental End Tser License
hgreement (TSupplemental EULLY), including any
"online™ or electronic documentation (collectively
"hdate Snfrware™ . ia subhdernt £o the terms and ;I

%' I accept the terms in the License Agreement.

" I do not accept the terms in the License Agreement,

< Back I Mext = I Cancel

K 3-11  [FlE sp4 Z &bl

12, R TIFUH%%E spd, Mk 3-12,
x4

Installing eMbedded Yisual C++ 4.0 SP4

Please wait while the Setup Wizard installs eMbedded Visual C++ 4.0 5P4. This
may take several minukes,

Skatus:

= Back | [0

3-12 %% sp4
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13. sp4 LZRSEMLLG, 1817 “SOFTWARE/SDK” H 3k G TRy SDK %
FeRERe, AL EM9160_SDK.msi 4. 4 L&l 3-13 Prosxiifie, 4% Accept, [fl
i ENO160 License Agreement X

End-User License Agreement
Be sure ko carefully read and understand the Following end-user license agreement,

and then indicate whether vou act%pt or do nok accept the terms of the agreement.,

This software will not sek up on your computer unless you accept the terms of the agreement,
For wour Future reference, you may prink the text of the agreement now using the PRIMT
button or obtain the text from the ™M3SFT_SDK_EULA_1033.rtf file after installation. You may
also receive a copy of this agreement by contacting the Microsoft subsidiary serving wour
country, ar wrike: Microsoft Sales Infarmation Center, One Microsaft ‘Way, Redmond WA

95052-6399,
S
END-USER LICENSE AGREEMENT FOR
MICROSOFT SOFTWARE
MICROSOFT CUSTOM SOFTWARE DEVELOPMENT KIT FOR WINDOWS CE 5.0
{Referred to as the "Microsoft Custom SDK™)
w

Press the PAGE DR kew ko see mare text.

[ < Back. ” Mexk = ] [ Cancel

3-13  [A]& SDK Z23 Y
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14, HILWE 3-14 FXHGHER & +E Complete.

i Em0260_0T1112 Setup ) x|

Choose Setup Type
Choose the setup type that best suits vour needs

Custom

Allows users to choose which program features will be installed
and where they will be installed. Reconmended Far advanced
users,

Complete

Al program Features will be installed. {Requires most disk,
space)

< Back Mext = Cancel

314 bk
15, BRI 315, SEHELUR, HEEIHEI A b
x|

Installing Em9260_071112

Please wait while the Setup Wizard installs Em3260_071112, This may take several
minukes.

Skatus:  Copwing new files

= Back Mext =

Kl 3-15 SDK Ze3kid i
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3.2 HAITRARHILE
1. e BRI LG . $TJF “SOFTWARE/config” H 3%, K HLifi ) dbginfo.txt
SLRIBIA AR, FEARME T T A5 SOE 28 OCFIXA SRR B A8 55D,
DLEF M I KRB ] . ALK OGN 192.168.201.8; JF &K FHLH 1P Hitik 2y
192.168.201.4; TSl 255.255.255.0; K 7afil ARMO ik AZUBEER AL 1P kil
192.168.201.205.
I dbginfo.txt SCAF P 2N i 48 1 F
[LOCAL_MACHINE]
DefaultGateway="192.168.201.8"
IPAddress="192.168.201.205"
SubnetMask="255.255.255.0"
[HOST_MACHINE]
IPAddress="192.168.201.4"
port="9300"
[SYSTEM]

Store="50"

2. BHEERE RATIZA ORISR U B B, SRJEK U SEEAE T R EF1) USB 2
Mk, EHEZ9EE) ARMY IR AR
W 1. USRI FAT sl FAT32 SO &R 48, 5 W5E 6] ARMO ik A sUBEHR G 1 1
BN 2 . GRS R U B, SR ASEOEIE D
2. dbginfo.txt 20 7E 2 B R E L U B A S5 6] ARMO i A A . s
WMARBEHES, WIETEIITHAE R A . AURICEAAE, BB
JE TR U iEAE A 6] ARMO iR A BT R .
3. BN ANXBYUE BN G, WAL pe Hlim i ar 25 fF R, HA ping IR A ZUREER
() ip ik, DA A R 2% 2 DGR Y

3. JFHLEDEG) ARMO ik AR S U B2, P T RLE WL U B ERgFR7R T
Wzl et (U & BRI TN g) LS, R ENLEEE) eVC, RJE1EHE
Tools->Configure Platform Manager..., Wi 3-16.
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Tools Window Help

/‘1 Errar Loakup

A% Remate Call Profiler {WCESOD)

A% Remate File Viewer (WCESOD)

A% Remate Heap Walker (WCESOD)

A Remote Kernel Tracker (WCESOO)

/‘5 Remote Performance Monitar (WCESOO)
A% Remate Process Yiewer (WCESOO)

A Remote Registry Edikor (WCESIO)

A% Remate Spy-++ (WCESOD)

A Remote System Information (WwCESOO)
A% Remate Zoormin (WCESOO)

Select Remoke Tools *
Custorize, ..
Options. ..

ﬁ Macra...

Record Quick Macro Zkrl+Shift+R,
Play Quick Macro Chrlshife+P

Canfigure Platform Manager. ..

3-16  PACE AL

4. FEAT IR EHER L H AR k4% (40: EM9160 Device), ARGk LM
Properties..., Wi 3-17.

¥indows CE Platform Nanager Configuration

Select a platform or dewice to
—-_——— Ll o -

Add Dewice

+-@® Windows CE Default Flatform Delete

‘roperties. . .

i

About

3-17 B EA) ARMO i A SCRHR (1 e
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5. 7t Device Properties X} 1% HE[] Transpor H1i%$¢ TCP/IP Transport for Windows
CE, 7t Startup 11i%+¢ Manual Server, 8} 5 1% 4% Transpor 171/ [f] Configure..., 4] 3-18.

Device Properties

Dewice

EM21G0 Dewvice %

Select a transport and a startup server. Choose Test to
verify that wou can establish a commection to wour target
dewice with the selected transport and startup server

Transpor:

|TCPfIP Tran=zport for Windows CE ﬂ Configure. ..
Startup

|M9.nu=al Server ﬂ Configure. ..

Cancel | Test |

K 3-18 EFEEENI RN

6./2)i% Fixed port, J1:7r 47141 /¢) Port number F#ii A\ 9300, 24 J5 £ Use fixed address

AILIEFETT R EHLEY 1P shik, dnl&l 3-19.

TICPfIP Transport Configuration r5_<|

Configuration for dewvice:
ErMITE0 Device

[v Check connection status Interyal [meec): W
[+ Fixed port Fart number: IW
Host IP
{* Use fived address: 19218820120  ~|

" Configure automatically over zerial

ok Cancel

3-19  TiCE P45 i LRI IT R TALRY 1P Mok
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7. ESERE OK, K4 = ANXHHE . 4R 5 & $¢ Tools->Remote File Viewer(WCE500),

& 3-20 iR

Tools ‘Window Help

1 /7‘1 Error Lookup

™ Remote Call Profiler (WCESOD)
A Remote Eile Viewer (8WCESOD)

© A Remote Heap Walker (WCESOD)

A Remote Kernel Tracker (MWCESOD)

A Remate Performance Monitor (WCESOO)

/h,- Remate Process Yiewer (W CESOO)

A Remote Registry Editor (WCESOD)

A% Remote Spy-++ (WCESOD)

A Remote Swskem Information (WiCESOO)

A4 Remote Zoomin (WCESOD)

Select Remote Tools r
Customize. ..
Options. ..

'ﬁ Macra. ..

Record Quick Macro Ckrl+5Shift+R.
Play Quick Macro Ckrl+35hift+F

Zonfigure Platform Manager. ..

3-20 £+ Remote File Viewer

8. TEFH FIXTTRAE R IEFE Hbr i ss (40: EM9160 Device), Wil 3-21 fion.

Select a Wandows CE Dewice

=@ EN3160
£ EMI1E0 Device
+-@® Windows CE Default Flatform

Cancal

www.emtronix.com
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9. 1k # OK HAHLT 15 B, REUTTR 5 9E6) ARMO ik A SUBEREETIER:, wilE 3-22.

Connecting to device

Device
IEM‘EIEEEI Dewvice

Eztablizshing platform manager conmection to device

TCPFfIP Transport for Windows CE

3-22  JFRENH SR ARMO ik N ABEH g 3% 4

10, EHEL LA, Ko w00 ARMO RN USRI SO R, il 3-23. &
BE, BRAEIT AR5 2 2 E B 58 1o

EX Windows CE Remote File Viewer ‘ZHE'E'

File Y¥iew Comnnection Help

2q| 20| B[ €5 oa|=[EE =
+ EWS1E0 Device |- dpplication Data
IZ0My Documents

|Z] HandFlash

] Hetwork

|0 Program Files

IZ0 Recycled

I Tenp

[C ] Windows
[FAcontrol Panel 1nk

Ready mm

K 3-23  EH M, MU R 9 E] ARMO A USRS B SO PHE R

www.emtronix.com 23 028-86180660




JAME BEARA R A E] TR A EMO160 1 HH 24132 V1.0

4 eVC MHREFIT R

HEALLFHER) ARMO N UBCHUIT T (KRR SR TF R IREE, R LLK RO IF R LR
78] ARMO R N SBHERE R DI LU, I st LU eVC T 1l B Sl BN RS
¥ 7T

eVC JFARFAEENIGE 1K) VC ARHAHAEL, 2y DU i _EARH WK VC B4 BER
KAAT I AR TT I ) o ARTT, AEH eVC JFAM VC B KIX 2 —7ET VC JFRKIFEF?
BT Tl PC HL: eVC JFAR N R e 2 2445 HARBLIm AR PC ML Lz ATl X —

R R VC B S I NI ik A xCR Ge i LRI T AR 1) o PR, AFH /4 eVC
IRE R B AR 07 10 LA R AR s AT R L Ia AT AT NI RE P (0 7525, AR5 Rl =AM
PRI R AR 7 SR A SR U AT 4 eVC IF R I HARHL T AE FH P R AT A s AT 72
F, % A X =AM AR EMO160 (14 7 sU LA SR &AM WA, 4% LCD Woi
e, BEL BUKIM LT 10 F4ES

41 Qg eVC EFE
1. EMO160 1E 7 JA 8l LA 1Y S8 1w 0 40 1] 4-1

FoQUR L]
EMO260H: A FLEH
Emntronix & EM3ZE0 © 2007

Bl 4-1 Sef) ARMO i N 2UBEHR IE 3 5 3 LU 11 Sk 7 i T
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2. B3 eVC, it# File->New..., K& 4-2 fi/~.

File Edit Wew Insert Pro

e, b |
(= Open. .. Chrl+0

Zlose

Cpen Workspace, .,
Saye Workspace
Close Warkspace

H Save Chrl+5
Save f5..,

ﬁ Save ol

Fage Setip. ..
&S5 Print... Chrl+F

Recent Files »
Recent \Waorkspaces  »

Exit

Kl 4-2 1F eVC Hifrgt

3. 7 Projects T 1% £ WCE Application, J{{r4ii/1 Project name i N\ T4
% hello, E Location H1458 ¢ 1% T REMIAAGALE, 11 4-3 FioR.,
fen 21x]

Files Projects |Workspaces |

[E]WCE aApplication Project name:
L1 WCE ATL COM AppWizard

|hello
|%] WCE Dynamic-Link Library
WCE MFC ActiveX ControlWizard .
Location:
EWCE MFC AppWizard (dIl) e
SIWCE MFC AppWizard [exe) [D:istudyihello ]

%|WCE Static Library

@ Create new workspace
¢ Add to current workspace
["| Dependency of:

I El

CPUs:

CWin32 [WCE ARMV4) N
MWin32 [WCE ARMVAIL

[CWin32 [WCE ARMVAT)

CWin32 (WCE MIPS16)

[OWin32 [WCE MIPSII)

CWin32 [WCE MIPSII_FP] =

0K | Cancel |

4-3 LR
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4, FEFRMAHEHE S %L+ A simple Windows CE application., 1% 4-4 . SR)5
I Finish, JREFE OK A3t 1) TRE(S EHEHE, TFE hello BIg 7 5g b,

W/CE Application - Step 1 of 1 el L

“hat kind of windows application would vou
like to create ?

" An empty project.

" A simple Windows CE application.

" A typical "Hello ¥World!* application.;

< Back MNext > Finish Cancel

Kl 4-4  EPE TR

5. eVC 3R, w7 AR VC —FE. 18] 4-5 72 hello Hf 3Cff.

J_ hello ~||EmM3000
e

= hello files
EI «S Source Files

. #] hello.cpp

....... Stdhfx cpp
I 23 Header Files
#-[_] Resource Files
- ReadMe.b<t

q [
*acl... |@Re...| ZFil...

K 4-5 TFE hello i3 fF
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6. MR ARG . A B TR A RREIS CA] DL a5 A
Build->Execute 5 # il Pftt i CtrI+F5 $iT %4, WK 4-6 Pin, JFiELkiksE OK
DARAA T Y BT AE, TR TF R S AT -

[y E ol

4-6  4wiFiz4T hello

4.2 HEEITENATREITRER
1. % Tools->Remote File Viewer(WCE500), ##:4 / LLJ5, #1JF “EM9160

Device/NandFLASH”, Wi& 4-7 fins.

BN Windows CE Remote File Viewer E”Elgl

File Y¥iew Comnection Help

2ol gn| B/ 2 [fEE | @[] x] 1|4

EM9Z60 Device |_JDocuments and Settings
(3 Fetwork dbginfo. txt
4123 FeandFlash stepl_led. exe
+ (1] USBDisk
{3 Recycled

{1 Application Data
1 My Tocuments
[ Program Files
3 Tenp

47 Windows

K 4-7 EM9160 NandFLASH H 3 e

2. fTJF “SOFTWARE/config” H3k, ¥4I userinfo.txt SR AHMERL, FHAR
P BT AE A 25 DL A 2 T IXASCF I LS8 —35).

LAZE BT R IREE Syl ASHB G4 192.168.201.8; 1MLk 255.255.255.0; X
G ARMO ik A SRR H 2y A IP ik 192.168.201.205 5 Him 4T 1 30 2
STEP1_LCD.exe;: 5%,

1] userinfo.txt SCA- IR P 2% 8 4 i Gl F

[LOCAL_MACHINE]
DefaultGateway="192.168.201.8"
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IPAddress="192.168.201.205"
SubnetMask="255.255.255.0"
[USER_EXE]
Name="\NandFLASH\STEP1_LCD.exe"
Parameters=""
[SYSTEM]
Store="50"
1: userinfo.txt AN 7 75 5 R G8 TAE Tia AT AU I A G 0F AL 2 e @i,
DR ARG TAE TR, MIDERERA S [N, o i M S B R 2 1
UL~ Y dbginfo.txt HEYIEANAE, SR R SRS bR TAEPIE A

3. siififr BJ7 THE P s A m L&k (i n] LUl 5 .42 1) File->Export File 11T
22D, WE 4-8 Pron, (EHH O IEHE P IERENIA gL 1) userinfotxt, L, I
SHIF eI (ki STEP1_LCD.exe B4R HIE] T “NandFLASH” HkHh, Fik
Toiwe FHRE . W P 145 2 N R P I ANAE “NandFLASH” Hsgrhr, U2 fg H [R)
FER LS E D

Efa|x] o]

4-8 F# userinfo.txt

4. WITIF AR L1 JP1, ER ARS8, JTHLLUG &R 48 H 34T #e) STEP1_LCD.exe,
BN 4-9 Fron. WHEsAT BN s T MR . (P i T oS I TR e
RN B A BEE R ED

Kl 4-9 1217Fv)E LCD Som i
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4.3 STEP1

STEP1_LCD &M TIl& LCD B nfEfr. Xili “ AT TR \step1_lcd\step1_lcd.vew”,
Ja5h setp1_led TFE. 4/ IEAfi 223 T EM9160 i) SDK Ji, {45 LCD_API.LIB 7£ PN K] %
A OB RIF R ENUA N H %R . #:4F LCD BoRi) &M% M s $oe XA LCD_APLH
F, WESDSH G TSR RN E Lo B S AS e B s B e B AE
LCD_API.LIB "1, FHZEFLF bt %] LCD o, % PRJ SCAFH Link i% LIB .
1 F¢ Protect->Settings % B Ul T :

Froject Settings

Settings For: General | Debug | CIC++ Link | Resources | M EE
Wini2 CE ARMVAI] Debu hd
wing2 (W 105008 7)) Coteqory: [N -] esct

+

Output file name:
|ARMV4|Dhgrstep1_|cd.exe

Objectflibrary modules:
|cummctrl.|ih coredll.lib EM9160_ISA_DIO.lib lcd_api.lib

v Generate debug info I_L\%gnnre all default libraries

[~ Generate mapfile

Project Options:

commctrl.lib coredil.lib EM9160_ISA_DIO.lib lcd_api.lib ~
inologo tbase!'0x00010000" /stack:0x10000,0x1000
fentry:"WinMainCRTStartup” fincrementalives

0K | Cancel

W

Kl 4-10 B BEH PR SO
STEP1_LCD ARG R
#include "stdafx.h"
#include "lcd_api.h"  //E445 led_api Sk30F
// initialize LCD
type = LCD_Init( LCD_AUTO );
/ltype = LCD_Init( LCD_12864 );
/ltype = LCD_Init( LCD_240128 );
/Itype = LCD_Init( LCD_320240 );

if( type<0) return -1;
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MaxX = LCD_GetMaxX( );

MaxY = LCD_GetMaxY( );

RowNum = MaxY/16;
RowsStart = ( RowNum - 4 )/2;

Rowldx = RowStart;

/I show chinese char at center position
strepy( BufStr, "™* XL **");

x = (MaxX-strlen(BufStr)*8)/2;

y = Rowldx*16;;

LCD_WriteString( x, y, BufStr, 1);

Rowldx++;

strepy( BufStr, "fik A2 £ i );
x = (MaxX-strlen(BufStr)*8)/2;

y = Rowldx*16;

LCD_WriteString( x, y, BufStr, 0 );

Rowldx++;

/I draw lines
LCD_DrawLine( 0, Rowldx*16, MaxX-1, Rowldx*16, 1 );
Rowldx++;

LCD_DrawLine( 0, Rowldx*16, MaxX-1, Rowldx*16, 1 );

/l draw curve

for( x=0; x<MaxX-1; x++)

{
y = (Rowldx*16-8) - 8.0*sin( 2.0*M_PI1*x/24.0 );
LCD_PutPixel( x, y, 1);
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for( x=0; x<MaxX-1; x++)
{
y = (Rowldx*16-8) - 8.0*sin( 2.0*M_PI*x/24.0 );

LCD_PutPixel( x, y, 0 );

LCD_FiliBar( 0, Rowldx*16, MaxX-1, (Rowldx+1)*16, 1 );

LCD_FillBar( 0, Rowldx*16, MaxX-1, (Rowldx+1)*16, 0 );

Sleep( 5000 );
LCD_Clearup( );
LCD_Delnit( );
UENEWARF
1. B3zt sl T AR ' A LUE 2R H#isAT, BoninEl 4-9 Pk,

Frek 5 B i,

|step1_led - |[EMI16D _~|[win32 (wCE ARMVAI Debug  ~|[EM9160 Device | = ' ELm

'Win32 [WCE ARMY4I) Debug

2. fELIIR. i =, s s o B

PRE O, TSI, 1 411
yie O ST L B 4T
3. 1 e et

FRI AT NIR 1616 FET R, WERARAEAEH P, 2L e PR R 7, 33
ABATHRR -
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soft elbedded Visual C++ [break] — [stepl lcd.cppl

B stepl 1cd — Nicro,

[ File Edit View Insert Froject Debug Tools Hindow Help == x|
A B DERm e
| (Globals) || (Al global members - || ¢ WinMain ~|B -
[stept_led -] I | ol @ e A EH e PR s BEEDES
¢ |

/#/ TODD: Place code here.
int %, y, type, MaxX, Max¥, RouNum, RowStart, Rowldx;
char  BufStr[288];

// initialize graphics node
type = LCD_Init{ LCD_AUTO );
/7 type = LCD_Init( LCD_12864 );
/7 type = LCD_Init{ LCD_19264 };
/7 type = LCD_Init( LCD_248128 );
/ftype = LCD_Init( LCD_320240 );
| if( type<d ) return -1;
HaxX = LCD_GetMaxX( );
Max¥ = LCD_GetMax¥( );

RowHum = Max¥/16;
RowStart = ( RowNum - 4 )/2;
Rowldx = RowStart;

/¢ shou chinese char at center position

stropy( BufStr, == BMIlfE == );

% = (MaxX-strlen(BufStr)x8)/2;

y = Rowldx*16;;

LCD_Mritestring( x, y, Bufstr, 1);

Rouldx++;

/7 _Writestring( x, y, BufStr, LED_BACK, LCD_DOT );

stropy( Bufstr, “i A GLFIREIEER" ); I

% = (MaxX-strlen(BufStr)=8)/2;

n = RnuTdxxdf: 2
el | f
ﬂ“ Cantext: [WinMain{HINSTANCE__*, HINSTANCE__ *, unsigned short %, in{) | ﬂ Name Value

Name |Value

BUfStr[200] 48 "0

Haxi 66658928

Hax¥ [}

RowIdx 84548

RowNum a

RowStart 335806512

type 1

% 32

v 335544328

I\ Auto { Tocals % this I\ Watch1 { Watch? b Vatchs b Watchd

Ready

Ln 24, Col 1

Kl4-11  fELHREH
44 STEP2

FiFp STEP2_Serialtest =20fie 8 HIMNA, 457 ANFi o€ d DB B84k I, Kear
BT B B0 S e 1 25« IR ISR ) EMO160 245K GPIO SEBl T AN 3X3 I s,
DR p o) DL e E s okaB 1, iz | LCD, LCD ¥ o d i, Ik Hdis
KL LR B SR 1 SR

X1 EM9160 (1] ISA S4k UL f GPIO (1541 ik £ 1 5 XA EM9160_ISA_DIO.h 1, %
PRSI T RS RBUE o BRI BRI & 7 EM9160_ISA_DIO.LIB i,
FISTEP1 —#), STEP2 b %] T LCD oK, [Hi STEP2 i ] T EM9160 [ GPIO
Thfg, HUkAE PR SCIEAP A5 2R IN R LCD_APILIB fil EM9160_ISA_DIO.LIB, i F 4]

B
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Froject Settings Elgl
Settings For: General | Debug | CiC++ Link | Resources | M EE
Win32 (WCE ARMVYA4Il) Debu -
Win32 (W 10ebs 71 Coeqory: [T -] Rese

+ stepz_serial

Qutput file name:
|AHM\.'4|Dhg;stepz_sTial.exe

Objectflibrary modules:
|cummctrl.|ih coredll.lib EM9160_I15A DIO.LIB led_api.lib

v Generate debug info [~ Ignore all default libraries

[ Generate mapfile

Project Options:

commectrl.lib coredll.lib EM9160_ISA DIO.LIB ~
led_api.lib fnologo fbase:'0x00010000"
Istack:0x10000,0x1000 fentry:""WinMainCRTStartup™

0K | Cancel ‘

STEP2 i IR FF 18] EMO160 (1] COM3 [, FTLAZEIEAT R 3 7 24 COM3 [
SR i, JEE R BN PC M H DL, SRS E EMO160 Rk 4T
step2_serialtest F£/¥>. 7& PC Hl 3247 “ & B 77 B o Windows [ “ 2% £iii 7
FEFe, o IRBY T BPAETT AOGHER “IRTH” H N o RGIEFLF & RS 4L
9600 Bk A . 1 AMFEIAL, 8 NEIEAL. oA AL, M ridiAkik. WA EM9160 #: 11T
YEIEH , EM9160 ) LCD 4t W Fe et A A IR B O, PC AL ke & 1) EM9160
BRI 4 - EMO160 iz AT Ml A2 v m] DAmi . F2eg, 46 g (B 1 7= E LCD
b, s [KINO - KOUTO] 4%, STEP2_serialtest FJ 7Kl .

4.5 STEP3

STEP3_tcptest 1= Z N T LKL, 2R IDIRE R EL— AT TCP [ikgs

, WIWT TCP HERE, WS, R A BRIE RO BB, vT LA S I IR ) 15
B IRAE AT S, 0T A B B A TS % i e TR R STEP2 —
FEZFF M T LCD SR LLEH S () B 4F , Rk STEP3 1y PRJ 1% & fil STEP2
_—y

STEP3 F&JFHA TR, E5EfE EM9160 t K iafrixfe)y, RJ57E PC #l iz
tcptest.exe, tcptest F2/7E FEFF A IR “MNK TH” H3 . EXfHES, 8 “&K)
BL70 7E “MRS5 4857 A2 H Pk EM9O160 1 IP Hadik (4. 192.168.201.175), A5
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s “HEEHE7, TCP 4 —HAr, JERAG WS BRI BOBOS, WNTA 8 i kIE 5,
Pk I8 BN U, i SRR RHE T, B ANENATAT A AF i, AT Ki%, toptest
¥ 3% VS B ) A 4 LA PC HLI R 40 TH) 1) EM9160, EM9160 Wi Bl 5, K% &4k
I ) B B EMO160 it b W RAE N BHE D, BN FARF “Time”, s RIEfE, AR
BEHU R Z 4 5, RS EMO160 LIRSl i, A e N 1 R B EK PC. dn
BAEF AR KR, EMO160 WK /S, 24650 IR M 2L PC. 7] STEP2
R, IS AT A R R A N g, R B R R s AE LCD L, i i A HLKINO
- KOUTO] %%, STEP3_tcptest FL/FKil .

ZTCP Test X
Eﬁ$¥¥|§Fm vI m%ﬁﬁw|mzmaana
Be@mo [roo == I i

e | #iz |

HetBox Set

Time

123456

Time

2007-12-10 15:46:03
Z007-12-10 15:46:07
123456

Z007-12-10 15:46:15

AR SRR
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